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Register for an Account 

In order to file documents electronically and to access your appeals on CAMS, you must 
register for an account. To obtain a CAMS account, you must be a lawyer, work in a law firm 
or be a self-represented litigant with a matter before the Court of Appeal. Accounts are not 

available to the media or members of the public. 

 

Register for an Account 

1. Visit https://cams.albertacourts.ca/public-portal/  and click on the “To register for an 
account, click here”.  

 

2. The User Account registration form 
will appear. User accounts fall under 
one of two categories: Law Firm or 
Self-Represented Litigant. 

 
  

https://cams.albertacourts.ca/public-portal/
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Litigants who do not have a lawyer should register as a Self-Represented Litigant 
account. Lawyers (and support staff within a law firm) should register as a Law Firm 
Account. However, if a Law Firm will have multiple users within the firm, that firm can 
be assigned a Law Firm Administrator account which will enable the holder of that 
account to create and manage individual accounts for other users within the law firm 
without having to obtain approval of the Registrar. Before a lawyer registers for an 
account, he or she should first determine whether their law firm already has a Law 
Firm Administrator account. See further information at the end of this document. 

3. All areas marked with an asterisk 
must be completed.  

 

4. Acknowledge that you have read and 
accepted the Terms of Use, enter the 
required CAPTCHA and then click the 
Create new account button. 
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5. The following message will appear at the top of the screen: 

 

When you submit a request to become a registered user, you will receive an email 
acknowledgement of that request. Best efforts will be made to review and approve 
the request on the same day that the request is received (provided the request is 
received during business hours). When your request is approved, you will receive 
another email with log in instructions. Emails will be sent from 
CAMSInquiries@albertacourts.ca.  Please ensure that your spam filters do not block 
these email addresses. 

Law Firm Administrator Accounts 

A Law Firm Administrator account is a law firm user account with the following elevated 
privileges: 

 
• the ability to create and manage accounts for other users within that law firm; and 
• the ability to grant (or remove) access to that firm’s appeals to other users within that law 

firm. 

If you do not know if your law firm has a Law Firm Administrator, or if you do not know the name 
of your Law Firm Administrator, please email CAMSInquiries@albertacourts.ca.   

To obtain a law firm administrator account, a member of the law firm must become a registered 
user. That person does not necessarily have to be a lawyer and can be an assistant, paralegal or 
other support staff. Then, the holder of that account must email CAMSInquiries@albertacourts.ca  
to request that the account be elevated to a Law Firm Administrator Account.  

For further information see the instruction sheet entitled “Law Firm Administrator Account”. 

mailto:CAMSInquiries@albertacourts.ca
mailto:CAMSInquiries@albertacourts.ca
mailto:CAMSInquiries@albertacourts.ca
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Log in to an Account 

In order to file documents electronically and to access your appeals on CAMS, you must log in 
to your CAMS account. 

 

Log in to an Account 

1. Visit https://cams.albertacourts.ca/public-portal/  and click on the “If you already have an 
account, log in”.  

 

2. Enter the email address and 
password associated with the 
account along with the required 
CAPTCHA. Once all fields are 
completed, click on Log In. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

https://cams.albertacourts.ca/public-portal/
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Once logged in, you will be directed to your My Account page from which you can initiate new 
appeals, view and file documents on existing appeals, update your account information and 
more. 

Update Account Information 

To change your password, log in to your 
account, click on My Account, and then 
choose the Account tab. 

 
To change your name or contact 
information, log in to your account, click 
on My Account and then choose the 
Personal Information tab. 
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Request a New Password 

If you have forgotten your password for your CAMS account, follow these steps. 

 

Request a New Password 

1. Visit https://cams.albertacourts.ca/public-portal/  and click on the “If you already have an 
account, click here”.  

   

2. On the User Account page, click on the 
Request new password tab. Enter the email 
address associated with the account along 
with the required CAPTCHA. Once all fields 
are completed, click on E-mail new 
password.  

 

https://cams.albertacourts.ca/public-portal/
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3. The following message will appear at the 
top of the screen: 

 

Once you submit a request for a new password, you will receive an email providing 
further instructions. Emails will be sent from CAMSInquiries@albertacourts.ca.  Please 
ensure that your spam filters do not block this email address. 

mailto:CAMSInquiries@albertacourts.ca
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Law Firm Administrator Account 

A Law Firm Administrator account is a law firm user account with the following elevated 
privileges: 

• the ability to create and manage accounts for other users within that law firm; and 
• the ability to grant (or remove) access to that firm’s appeals to other users within that 

law firm. 

If you do not know if your law firm has a Law Firm Administrator, or if you do not 
know the name of your Law Firm Administrator, please email 

CAMSInquiries@albertacourts.ca. 

   

Obtain a Law Firm Administrator Account 

To obtain a Law Firm Administrator account, you must first become a registered user (See the 
separate instruction sheet entitled “Register for an Account”.) That person does not 
necessarily have to be a lawyer and can be an assistant, paralegal or other support staff.  
Then, the holder of that account must email CAMSInquiries@albertacourts.ca to request that 
the account be elevated to a Law Firm Administrator Account 

Create and Manage Accounts for Other Users 

A Law Firm Administrator can create accounts for new users within the law firm without having to 
obtain the approval of the Registrar. To do so, follow these steps. 
 

1. Log into your CAMS account.  
 

2. On the gold-coloured menu bar at the 
top of the page, click on Manage/Add 
Users. 

 

 

mailto:CAMSInquiries@albertacourts.ca
mailto:CAMSInquiries@albertacourts.ca
https://cams.albertacourts.ca/public-portal/
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3. Click on +Add User. 

 

4. Complete the necessary fields and 
then at the bottom of the page, click 
on Create New Account.  
 

 
 

NOTE:  The name and contact information for the new user will be populated with 
the name and contact information of the law firm administrator. These fields 
will need to be changed to insert the name and contact information of the 
new user. 

The new user will receive an email with log in instructions. 

Share Access to Appeals with Other Law Firm Users 

A Law Firm Administrator can share access to appeals with other registered users within that 
law firm without having to obtain the approval of the Registrar. To do so, follow these steps. 

1. Log into your CAMS account.  

2. On the gold-coloured menu bar at the 
top of the page, click on Manage 
Appeal Access. 

 

 

https://cams.albertacourts.ca/public-portal/
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3. Enter the email address associated 
with the registered user with whom 
you want to share access. It is not 
necessary to complete the First name 
and Last name fields. Click on Search. 

 

4. Click on +Add New Appeal. 

 

5. Enter the Appeal Number to which you 
are sharing and then click on Search. 
The fields entitled eCourt Reference 
Number, eFiling Title and Submitted by 
(Email) are not in use. 

 

 

6. Check the box next to the Appeal 
Number. If you want the user to be 
notified that they have been granted 
access to an appeal, check the “Notify 
user of new case association” box. 
Then, click on +Add.  
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If you encounter difficulties with sharing access to appeals with other law firm users, please 
contact CAMSInquiries@albertacourts.ca for assistance.   

mailto:CAMSInquiries@albertacourts.ca
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Request Access to an Appeal 

Registered users can access the electronic court file and other information about their 
appeals including documents, deadlines, hearing dates, results and more. 

Automatic Access 

If you are the initiating party (i.e., you filed a Notice of Appeal or an Application for Permission 
(Leave) to Appeal), you will automatically have access to the appeal by logging in to your CAMS 
account and clicking on “My Appeals”.  

IMPORTANT NOTE:  Automatic access is given only to the user who was logged in 
when the commencement document was filed. If that user was a 
legal assistant, then the lawyer on that file will not have automatic 
access. In that case, the lawyer (and anyone else in the law firm 
that requires access to the appeal), should request that access 
through their Law Firm Administrator. (See the separate instruction 
sheet entitled “Law Firm Administrator Account”.) If you do not 
know if your law firm has a Law Firm Administrator, or if you do not 
know the name of your Law Firm Administrator, please email 
CAMSInquiries@albertacourts.ca. 

Requesting Access  

If you do not have automatic access to the appeal (e.g., you are a respondent), and you do not 
have a Law Firm Administrator, you must first become a registered user (see the separate 
instruction sheet entitled “Register for an Account”) and then request access to the appeal by 
sending an email to CAMSInquiries@albertacourts.ca providing: 

 
• your name 
• the email address associated with your account 
• your role in the appeal (e.g., respondent, counsel, etc.) 
• the appeal number to which you require access.  

 
If your request is granted, you will receive an email confirming that access has been granted. 

https://cams.albertacourts.ca/public-portal/
mailto:CAMSInquiries@albertacourts.ca
mailto:CAMSInquiries@albertacourts.ca
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V iew My Appeals 

Lawyers, support staff and self-represented litigants who are registered users can access their 
appeals, the electronic court file and information about their appeals including documents, 

deadlines, hearing dates, outcomes and more. To obtain access to your appeals, see the separate 
instruction sheet entitled “Request Access to an Appeal”. 

 

Find Your Appeals 

1. Log in to your CAMS 
account. 

 

2. Select the My Appeals tab. A list of all of the appeals that you have initiated in CAMS or for 
which you have been granted access will be displayed. If you have not initiated any appeals 
in CAMS or have not been granted access to any appeals, the list will be blank. Law firm 
users will also have a tab called My Organization Appeals which will display all the appeals 
that all users within that law firm have access to. 

 

Filter Your Appeals 

1. If your list of appeals 
is long, you can filter 
your appeals by 
clicking on Appeal 
Search. 

 

2. The following search criteria can be used: 

https://cams.albertacourts.ca/public-portal/
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• Appeal Number – use this field to search for an appeal by appeal number (e.g., 1803-

0000AC) 
• Style of Cause – use this field to search for an appeal by name (e.g., Jones) 
• Reference Number – not in use 
• eFiling Title – not in use 
• Status – use this field to search for all active appeals or all closed appeals. Leaving the 

selection blank will search for both. 
• Filing Date From/To – use these fields to search for all appeals that were filed between a 

given date range (e.g., 2019/06/01 – 2019/12/31). 
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Once your filters are complete, click Search to view a list of appeals that match your search 
criteria. 

View Your Appeals 

1. On your My Appeals page, find the particular appeal that you wish to view. From the Select 
Action drop-down menu, choose View Summary. 

 

2. A page will appear displaying information about the appeal beginning with an Appeal 
Summary. Below the Appeal Summary section are sections for Parties/Representation, Lower 
Court Information, Charge and Sentence Information (criminal only), Documents, Hearings 
and Deadlines. Click on the arrow to the left of each section to expand it. Click on the arrow 
again to collapse the section. 
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Appeal Information 
Appeal Summary • Appeal Number 

• Style of Cause 
• Appeal Location (Edmonton or Calgary) 
• Appeal Type 
• Appeal Filing Date 
• Ban/ Restricted Access (Any restricted access 

orders or publication bans associated with the 
appeal will be listed. If there are none, this section 
will either be blank or will display “No Ban on 
Publication”. 
 

Parties/Representation • Names of all parties to the appeal 
• Names of lawyers for each party (if applicable) 

 
Lower Court Information Criminal 

• Name of the judge or justice whose decision is 
under appeal 

• Trial court location 
• Date of conviction (or decision) 
• Date of sentence (if applicable) 
 

Civil 
• Trial court file number 
• Name of the justice whose decision is under 

appeal 
• Date of the decision that is under appeal 
 

Charge and Sentence 
Information (Criminal only) 

• Charge file number 
• Charge 
• Criminal Code or other statutory section number 
• Sentence 
 

Documents • Link to download the document for viewing. 
• Date the document was filed 
• Name of the document 
• Type of hearing to which the document applies (if 

applicable) 
• Name of the party that filed the document 

(Documents created by the Court will be displayed 
as filed by “Court”.) 
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Hearings • Date 
• Time 
• Type 
• Result (once known) 

 

Note:   The names of the judges hearing a matter will be available on the Hearing List 
posted on the Court’s website approximately 1 week before the hearing takes 
place or in the clerk’s notes that are posted in the Documents section once 
the hearing is concluded. 

Deadlines Pending deadlines for: 
• Appeal Record 
• Appellant’s Factum 
• Respondent’s Factum 
• Reply Factum (if any) 
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File A New Civil Notice of Appeal  

All documents must be in PDF in order to be filed electronically and must comply with the 
formatting requirements set out in the Practice Direction on Electronic Filing. If you need to file a 

photo or video file or another document in a format other than a PDF (e.g., JPEG, MP3, MP4, etc.), 
send it on a USB or CD to the Registry and ensure that it can be easily viewed or played using a 

standard Windows Media Player. 
 

File a New Civil Notice of Appeal 

1. Log in to your CAMS account.  

2. Select File a New Civil Appeal/Permission 
to Appeal on the left-hand side of the page. 
On the next page, select New Civil Notice of 
Appeal.  

 

 

https://cams.albertacourts.ca/public-portal/files/practiceDirection.pdf
https://cams.albertacourts.ca/public-portal/
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After reading the instructions, begin completing the fields. All fields with an asterisk 
must be completed. 

Registry Office 

3. Select the appropriate Registry Office (Calgary or Edmonton). For appeals arising in the 
judicial centres of Calgary, Drumheller, Lethbridge, Medicine Hat or Red Deer, select Calgary. 
For appeals arising in all other judicial centres, select Edmonton. 

 

Appellant Information 

4. Enter the name of the Appellant exactly as it appears in the order, judgment or decision that 
is being appealed. Use Last Name, First Name, Middle/Initial if the appellant is an individual. 
Use Corporate/Organization Name if the appellant is not an individual. 

Note:   If there is more than one appellant, click on +Appellant and repeat the steps 
below for each appellant. If there are more than three appellants, you need 
only enter the first three. The Registry will enter the remaining appellants. 

 

5. If necessary. use the Other Description field to complete the appellant’s description (e.g., 
Carrying on Business As, Operating As, By Her Litigation Representative, etc.) 
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6. Select the appropriate status in the court appealed from for the appellant. 

 

7. Select either yes or no to the question “Is the appellant self-represented? 

 
a. If the appellant is not self-represented, in the Appellant lawyer section, begin typing the 

last name of the lawyer for the appellant and then make the appropriate selection from 
the names that appear. If the lawyer’s name does not appear, type their first and last 
name in the fields and continue. 

 
Note:   If there is more than one appellant lawyer, click on +Appellant Lawyer and 

repeat the steps above for each lawyer.  



CAMS MANUAL 

25 
Version 2.2 

b. If the appellant is self-represented, enter the appellant’s address and contact 
information, including an email address. 

 

 

Respondent Information 

8. Enter the name of the Respondent exactly as it appears in the order, judgment or decision 
that is being appealed. Use Last Name, First Name, Middle/Initial if the respondent is an 
individual. Use Corporate/Organization Name if the respondent is not an individual. Follow 
the same steps re: status in the court appealed from and representation that you did for the 
appellant above. 

Other Court/Previous Decision 

9. Make the appropriate selection for What type of order, judgment or decision are you 
appealing: Provincial Court (Civil Trial Court), Court of Queen’s Bench (Civil Trial Court), 
Board, Tribunal or Prof. Disc. Body, Reference. 

 
Appeal from the Provincial Court of Court of Queen’s Bench 

10. Enter the name of the judge or justice whose decision is being appealed. Begin typing the 
last name of the judge or justice and then make the appropriate selection from the names 
that appear. 
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11. Enter the Trial Court File Number. If there is 

more than one file number, click on +Trial 
Court File # 

 
12. Enter the Provincial Court Location or Judicial Centre. Begin typing the first three letters and 

make the appropriate selection. If there is more than one option, hover your mouse over the 
name to select the correct one. 

 

 
13. Enter the date that the order, judgment or decision that is being appealed was made 

(pronounced) by clicking on the calendar icon and choosing the date from the calendar. 
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14. If there is a neutral citation, enter it. 

 
15. Select either yes or no to the question Did the matter originate with a Master or in the 

Provincial Court of Alberta and was then subsequently appealed to the Court of Queen’s 
Bench? 

 
If the answer to the above question is yes: 
a. Enter the name of the master or judge. Begin typing the last name of the master or 

judge and then make the appropriate selection from the names that appear. 
b. If there is a neutral citation for the decision of the master or judge, enter it. 

Appeal from a Decision of a Board, Tribunal or Professional Discipline Body 

16. Complete the following fields: 
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Publication Ban/Access Restriction Information 

17. Answer the 5 questions about Publication Ban/Access Restriction Information. 

 
Note:   If questions 1-4 have been answered in the affirmative, or if question 5 was 

answered in the negative, please provide a copy of any relevant order. If the 
order was pronounced orally, please provide the relevant excerpt from the 
transcript of the hearing in which the order was pronounced. If applicable, 
please also provide a copy of the legislation under which a publication ban 
or access restriction applies along with the specifics of the information that is 
to be protected. 

Upload Documents 

18. Upload the Notice of Appeal, the Order, Judgment or Decision under appeal and any other 
relevant documents by clicking on Choose File under the appropriate heading. 
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19. When the dialogue box opens, find the file that you want to upload. Select it and then click 

on Open. 

   

Note:  It does not matter how you named your document when you saved it. Once 
the document is uploaded and approved, the Registry will verify and select 
the correct document name. 

20. Once the document is uploaded, click on 
Proceed. 
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Note:  Documents cannot exceed 100MB. The larger the document, the longer the 
upload will take.  

21. You will be returned to your My Appeals 
page, and the following message will 
appear at the top of the screen: 

 
The new appeal will appear in your My 
Appeals page, but it will bear an appeal 
number with EF at the end. This is a 
temporary number only and should never 
be used on documents. A permanent 
appeal number will be assigned once the 
notice of appeal has been filed. 

 

Pay Filing Fee 

When you submit a document, you will receive an email acknowledgement of the 
submission. That email will include a link for the online payment of the $600.00 filing 
fee. Payment must be made immediately. Your document will not be processed until 
payment is made. Neither the Registry nor the Court will be responsible for a missed 
limitation period caused by a failure to make the required payment on time. 
 
Once payment is made and your document is reviewed, you will receive another 
email indicating whether the document was rejected, filed, filed on conditions or filed 
non-compliant. Emails will be sent from CAMSInquiries@albertacourts.ca. Please 
ensure that your spam filters do not block this email address. 

 

 

 

IMPORTANT NOTE    
The email acknowledgements will be sent to the email account of the user who 

was logged in when the document was submitted. For example, if a legal assistant 
was logged in to his or her account and submitted a document for filing, the email 

acknowledging the receipt of the document will be sent to the email address 
associated with the legal assistant and not to the lawyer’s email address. 

 

mailto:CAMSInquiries@albertacourts.ca
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File A New Civil Application for Permission to Appeal  

All documents must be in PDF in order to be filed electronically and must comply with the 
formatting requirements set out in the Practice Direction on Electronic Filing. If you need to file a 

photo or video file or another document in a format other than a PDF (e.g., JPEG, MP3, MP4, etc.), 
send it on a USB or CD to the Registry and ensure that it can be easily viewed or played using a 

standard Windows Media Player. 

 

File a New Civil Application for Permission to Appeal 

1. Log in to your CAMS account.  

2. Select File a New Civil Appeal/Permission 
to Appeal on the left-hand side of the page. 
On the next page, select New Civil 
Application for Permission to Appeal.  

 

 

https://cams.albertacourts.ca/public-portal/files/practiceDirection.pdf
https://cams.albertacourts.ca/public-portal/
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After reading the instructions, begin completing the fields. All fields with an asterisk 
must be completed. 

Registry Office 

3. Select the appropriate Registry Office (Calgary or Edmonton). For appeals arising in the 
judicial centres of Calgary, Drumheller, Lethbridge, Medicine Hat or Red Deer, select Calgary. 
For appeals arising in all other judicial centres, select Edmonton. 

 

Applicant Information 

4. Enter the name of the Applicant exactly as it appears in the order, judgment or decision that 
is being appealed. Use Last Name, First Name, Middle/Initial if the applicant is an individual. 
Use Corporate/Organization Name if the applicant is not an individual. 

Note:   If there is more than one applicant, click on +Applicant and repeat the steps 
below for each applicant. If there are more than three applicants, you need 
only enter the first three. The Registry will enter the remaining applicants. 

 

5. If necessary. use the Other Description field to complete the applicant’s description (e.g., 
Carrying on Business As, Operating As, By Her Litigation Representative, etc.) 
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6. Select the appropriate status in the court appealed from for the applicant. 

 

7. Select either yes or no to the question “Is the applicant self-represented? 

 
a. If the applicant is not self-represented, in the Applicant lawyer section, begin typing the 

last name of the lawyer for the applicant and then make the appropriate selection from 
the names that appear. If the lawyer’s name does not appear, type their first and last 
name in the fields and continue. 

 
Note:   If there is more than one applicant lawyer, click on +Applicant Lawyer and 

repeat the steps above for each lawyer.  
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b. If the applicant is self-represented, enter the applicant’s address and contact 
information, including an email address. 

 
 

Respondent Information 

8. Enter the name of the Respondent exactly as it appears in the order, judgment or decision 
that is being appealed. Use Last Name, First Name, Middle/Initial if the respondent is an 
individual. Use Corporate/Organization Name if the respondent is not an individual. Follow 
the same steps re: status in the court appealed from and representation that you did for the 
appellant above. 

Other Court/Previous Decision 

9. Make the appropriate selection for What type of order, judgment or decision are you 
appealing: Court of Queen’s Bench (Civil Trial Court), Board, Tribunal or Prof. Disc. Body, 
Reference. 

 
Permission to Appeal from the Court of Court of Queen’s Bench 

10. Enter the name of the justice whose decision is being appealed. Begin typing the last name 
of the justice and then make the appropriate selection from the names that appear. 
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11. Enter the Trial Court File Number. If there is 

more than one file number, click on +Trial 
Court File # 

 
12. Enter the Judicial Centre. Begin typing the first three letters and make the appropriate 

selection. If there is more than one option, hover your mouse over the name to select the 
correct one. 

 

 
13. Enter the date that the order, judgment or decision for which permission to appeal is being 

sought was made (pronounced) by clicking on the calendar icon and choosing the date from 
the calendar. 
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14. If there is a neutral citation, enter it. 

 
15. Select either yes or no to the question Did the matter originate with a Master or in the 

Provincial Court of Alberta and was then subsequently appealed to the Court of Queen’s 
Bench? 

 
If the answer to the above question is yes: 
a. Enter the name of the master or judge. Begin typing the last name of the master or 

judge and then make the appropriate selection from the names that appear. 
b. If there is a neutral citation for the decision of the master or judge, enter it. 

Permission to Appeal from a Decision of a Board, Tribunal or Professional Discipline 
Body 

16. Complete the following fields: 
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Publication Ban/Access Restriction Information 

17. Answer the 5 questions about Publication Ban/Access Restriction Information. 

 
Note:   If questions 1-4 have been answered in the affirmative, or if question 5 was 

answered in the negative, please provide a copy of any relevant order. If the 
order was pronounced orally, please provide the relevant excerpt from the 
transcript of the hearing in which the order was pronounced. If applicable, 
please also provide a copy of the legislation under which a publication ban 
or access restriction applies along with the specifics of the information that is 
to be protected. 

Upload Documents 

18. Upload the Application, Memorandum of Argument and any other supporting documents by 
clicking on Choose File under the appropriate heading. 
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19. When the dialogue box opens, find the file that you want to upload. Select it and then click 

on Open. 

   
Note:  It does not matter how you named your document when you saved it. Once 

the document is uploaded and approved, the Registry will verify and select 
the correct document name. 

20. Once the document is uploaded, click on 
Proceed. 

 
Note:  Documents cannot exceed 100MB. The larger the document, the longer the 

upload will take.  
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21. You will be returned to your My Appeals 
page, and the following message will 
appear at the top of the screen: 

 
The new appeal will appear in your My 
Appeals page, but it will bear an appeal 
number with EF at the end. This is a 
temporary number only and should never 
be used on documents. A permanent 
appeal number will be assigned once the 
notice of appeal has been filed. 

 

Pay Filing Fee 

When you submit a document, you will receive an email acknowledgement of the 
submission. That email will include a link for the online payment of the $600.00 filing 
fee. Payment must be made immediately. Your document will not be processed until 
payment is made. Neither the Registry nor the Court will be responsible for a missed 
limitation period caused by a failure to make the required payment on time. 
 
Once payment is made and your document is reviewed, you will receive another 
email indicating whether the document was rejected, filed, filed on conditions or filed 
non-compliant. Emails will be sent from CAMSInquiries@albertacourts.ca. Please 
ensure that your spam filters do not block this email address. 

 
IMPORTANT NOTE    

The email acknowledgements will be sent to the email account of the user who 
was logged in when the document was submitted. For example, if a legal assistant 
was logged in to his or her account and submitted a document for filing, the email 

acknowledging the receipt of the document will be sent to the email address 
associated with the legal assistant and not to the lawyer’s email address. 
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File A New Criminal Notice of Appeal  

All documents must be in PDF in order to be filed electronically and must comply with the 
formatting requirements set out in the Practice Direction on Electronic Filing. If you need to file a 

photo or video file or another document in a format other than a PDF (e.g., JPEG, MP3, MP4, etc.), 
send it on a USB or CD to the Registry and ensure that it can be easily viewed or played using a 

standard Windows Media Player. 

Not all criminal appeals are brought directly to the Court of Appeal. For example, 
appeals of summary conviction offences heard in the Provincial Court of Alberta are 

brought to the Court of Queen’s Bench. Any further appeal to the Court of Appeal 
requires permission to appeal. Parties are encouraged to review the applicable 
legislation to determine the necessary requirements. Further, in some instances 

permission to appeal is required before filing a Notice of Appeal. (See rule 16.4 of 
the Alberta Rules of Court.) Parties are encouraged to review  

the Alberta Rules of Court. 

File a New Criminal Notice of Appeal 

1. Log in to your CAMS account.  

2. Select File a New Criminal 
Appeal/Permission to Appeal on the left-
hand side of the page. On the next page, 
select New Notice of Appeal.  

 

https://cams.albertacourts.ca/public-portal/files/practiceDirection.pdf
https://www.qp.alberta.ca/1125.cfm
https://www.qp.alberta.ca/1125.cfm
https://cams.albertacourts.ca/public-portal/


CAMS MANUAL 

41 
Version 2.2 

 
After reading the instructions, begin completing the fields. All fields with an asterisk 
must be completed. 

Registry Office and other Information 

3. Select the appropriate Registry Office (Calgary or Edmonton). For appeals arising in the 
judicial centres of Calgary, Drumheller, Lethbridge, Medicine Hat or Red Deer, select Calgary. 
For appeals arising in all other judicial centres, select Edmonton. 

 

4. In Appeal By select who is filing the appeal: Accused, Her Majesty the Queen (Alberta) or Her 
Majesty the Queen (Canada). 

 
5. Choose the appropriate Type of Appeal (Acquittal, Conviction, Conviction and Sentence, 

Sentence, Decision or Reference). 
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Party Information 

Appeals by the Accused 

1. Enter the name of the Appellant exactly as it was entered in the trial court. Use Last Name, 
First Name, Middle/Initial if the appellant is an individual. Use Corporate/Organization Name 
if the appellant is not an individual. 

 

2. Select either yes or no to the question “Is the appellant in custody”. If the answer is yes, 
begin typing the first three letters of the name of the institution and then make the 
appropriate selection from the names that appear. 

 

3. Select either yes or no to the question “Is the appellant self-represented?” 
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a) If the appellant is not self-represented, in the Appellant lawyer section, begin typing the 

last name of the lawyer for the appellant and then make the appropriate selection from 
the names that appear. If the lawyer’s name does not appear, type their first and last 
name in the fields and continue. 

 
Note:   If there is more than one appellant lawyer, click on +Appellant Lawyer and 

repeat the steps above for each lawyer.  

b) If the appellant is self-represented, enter the appellant’s address and contact 
information, including an email address 

  

4. Select either yes or no to the question, “Does the appellant wish to be present at the hearing 
of the appeal?” 
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5. Select the appropriate Crown: Alberta or Canada 

 

6. If you know it, enter the name of the Crown lawyer. Begin typing the last name of the lawyer 
and then make the appropriate selection from the names that appear. If the lawyer's name 
does not appear, enter their first and last name in the fields and continue. If you do not know 
the name of the Crown lawyer, leave this section blank. 

 

Note:   If there is more than one Crown lawyer, click on +Respondent Lawyer and 
repeat the steps above for each lawyer. 

Appeals by the Crown 

7. Select the appropriate Crown: Alberta or 
Canada 

 

8. Enter the name of the Crown lawyer. Begin typing the last name of the lawyer and then make 
the appropriate selection from the names that appear. If the lawyer's name does not appear, 
enter their first and last name in the fields and continue 
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Note:   If there is more than one Crown lawyer, click on +Appellant Lawyer and 
repeat the steps above for each lawyer. 

9. Enter the name of the Respondent exactly as it was entered in the trial court. Use Last 
Name, First Name, Middle/Initial if the respondent is an individual. Use Corporate/ 
Organization Name if the respondent is not an individual. 

 

10. Select either yes or no to the question Is the respondent in custody? If the answer is yes, 
begin typing the first three letters of the name of the institution and then make the 
appropriate selection from the names that appear. 
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11. Select either yes or no to the question Is the respondent self-represented? If the answer is 
no, and you know the name of the respondent’s lawyer, enter it by following the steps set out 
above. 

Other Court/Previous Decision 

12. Make the appropriate selection for What type of matter are you appealing: Provincial Court 
(Criminal Court), Court of Queen’s Bench (Criminal Trial Court), Criminal Alberta Review 
Board, Reference. 

   
Appeal from Provincial Court or the Court of Queen’s Bench 

13. Enter the name of the judge or justice whose decision is being appealed. Begin typing the 
last name of the judge or justice and then make the appropriate selection from the names 
that appear. 

 
14. Enter the Provincial Court Location or Judicial Centre. Begin typing the first three letters and 

make the appropriate selection. If there is more than one option, hover your mouse over the 
name to select the correct one. 
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15. Enter the Provincial Court or Court of 

Queen’s Bench File Number. If there is 
more than one file number, click on +File 
# 

 
16. Select how the Crown proceeded: Indictment or Both Summary Conviction and Indictment. 

 
17. Enter the Date of the Decision, Conviction or Acquittal and the Sentence (if applicable) by 

clicking on the calendar icon and choosing the date from the calendar. If there is a neutral 
citation, enter it. 

 
Appeal from Alberta Review Board 

18. In the case of an appeal from a Criminal Alberta Review Board, complete the following fields: 
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Publication Ban/Access Restriction Information 

19. Answer the 5 questions about Publication Ban/Access Restriction Information. 

 
Note:   If questions 1-4 have been answered in the affirmative, or if question 5 was 

answered in the negative, please provide a copy of any relevant order. If the 
order was pronounced orally, please provide the relevant excerpt from the 
transcript of the hearing in which the order was pronounced. If applicable, 
please also provide a copy of the legislation under which a publication ban 
or access restriction applies along with the specifics of the information that is 
to be protected. 

Upload Documents 

20. Upload the Notice of Appeal and any other supporting documents by clicking on Choose File 
under the appropriate heading. 
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21. When the dialogue box opens, find the file that you want to upload. Select it and then click 

on Open.  

 
Note:  It does not matter how you named your document when you saved it. Once 

the document is uploaded and approved, the Registry will verify and select 
the correct document name. 

22. Once the document is uploaded, click on 
Proceed. 

 
Note:  Documents cannot exceed 100MB. The larger the document, the longer the 

upload will take.  

23. You will be returned to your My Appeals 
page, and the following message will 
appear at the top of the screen: 
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The new appeal will appear in your My 
Appeals page, but it will bear an appeal 
number with EF at the end. This is a 
temporary number only and should never 
be used on documents. A permanent 
appeal number will be assigned once the 
notice of appeal has been filed. 

 

When you submit a document, you will receive an email acknowledgement of the 
submission. Once your document is reviewed, you will receive another email 
indicating whether the document was rejected, filed, filed on conditions or filed non-
compliant. Emails will be sent from CAMSInquiries@albertacourts.ca. Please ensure 
that your spam filters do not block this email address. 

 
IMPORTANT NOTE    

The email acknowledgements will be sent to the email account of the user who 
was logged in when the document was submitted. For example, if a legal assistant 
was logged in to his or her account and submitted a document for filing, the email 

acknowledging the receipt of the document will be sent to the email address 
associated with the legal assistant and not to the lawyer’s email address. 
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File A New Criminal Application for Permission to Appeal  

All documents must be in PDF in order to be filed electronically and must comply with the 
formatting requirements set out in the Practice Direction on Electronic Filing. If you need to file a 

photo or video file or another document in a format other than a PDF (e.g., JPEG, MP3, MP4, etc.), 
send it on a USB or CD to the Registry and ensure that it can be easily viewed or played using a 

standard Windows Media Player. 

 

File a New Criminal Application for Permission to Appeal 

1. Log in to your CAMS account.  

2. Select File a New Criminal 
Appeal/Permission to Appeal on the 
left-hand side of the page. On the next 
page, select New Application for 
Permission to Appeal.  

 

  

https://cams.albertacourts.ca/public-portal/files/practiceDirection.pdf
https://cams.albertacourts.ca/public-portal/
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After reading the instructions, begin completing the fields. All fields with an asterisk 
must be completed. 

Registry Office and other Information 

3. Select the appropriate Registry Office (Calgary or Edmonton). For appeals arising in the 
judicial centres of Calgary, Drumheller, Lethbridge, Medicine Hat or Red Deer, select Calgary. 
For appeals arising in all other judicial centres, select Edmonton. 

 

4. In Application By select who is filing the application: Accused, Her Majesty the Queen 
(Alberta) or Her Majesty the Queen (Canada).  

 
5. Make the appropriate selection from Why is Permission to Appeal Required? (Summary 

Conviction Appeal, Costs Only, Other). 

 

Party Information 

Applications by the Accused 

6. Enter the name of the Applicant exactly as it was entered in the trial court. Use Last Name, 
First Name, Middle/Initial if the appellant is an individual. Use Corporate/Organization Name 
if the appellant is not an individual. 
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7. Select either yes or no to the question “Is the applicant self-represented?” 

 
a. If the applicant is not self-represented, in the Applicant lawyer section, begin typing the 

last name of the lawyer for the applicant and then make the appropriate selection from 
the names that appear. If the lawyer’s name does not appear, type their first and last 
name in the fields and continue. 

 
Note:   If there is more than one applicant lawyer, click on +Applicant Lawyer and 

repeat the steps above for each lawyer.  

8. Select either yes or no to the question “Is the applicant in custody”. If the answer is yes, 
begin typing the first three letters of the name of the institution and then make the 
appropriate selection from the names that appear. 
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9. Select the appropriate Crown: Alberta or Canada 

 

10. If you know it, enter the name of the Crown lawyer. Begin typing the last name of the lawyer 
and then make the appropriate selection from the names that appear. If the lawyer's name 
does not appear, enter their first and last name in the fields and continue. If you do not know 
the name of the Crown lawyer, leave this section blank. 

 

Note:   If there is more than one Crown lawyer, click on +Respondent Lawyer and 
repeat the steps above for each lawyer. 

Applications by the Crown 

11. Select the appropriate Crown: Alberta or 
Canada 
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12. Enter the name of the Crown lawyer. Begin typing the last name of the lawyer and then make 
the appropriate selection from the names that appear. If the lawyer's name does not appear, 
enter their first and last name in the fields and continue 

 

Note:   If there is more than one Crown lawyer, click on +Applicant Lawyer and 
repeat the steps above for each lawyer. 

13. Enter the name of the Respondent exactly as it was entered in the trial court. Use Last 
Name, First Name, Middle/Initial if the respondent is an individual. Use Corporate/ 
Organization Name if the respondent is not an individual. 

 

14. Select either yes or no to the question Is the respondent in custody? If the answer is yes, 
begin typing the first three letters of the name of the institution and then make the 
appropriate selection from the names that appear. 
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15. Select either yes or no to the question Is the respondent self-represented? If the answer is 
no, and you know the name of the respondent’s lawyer, enter it by following the steps set out 
above. 

Other Court/Previous Decision 

Summary Conviction Appeal 

16. Enter the name of the Provincial Court Judge. Begin typing the last name of the judge and 
then make the appropriate selection from the names that appear. 

 
17. Enter the Provincial Court Location. Begin typing the first three letters and make the 

appropriate selection. If there is more than one option, hover your mouse over the name to 
select the correct one. 
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18. Enter the Provincial Court File Number. 
If there is more than one file number, 
click on +Provincial Court File # 

 
19. Enter the Date of the Decision, Conviction or Acquittal and the Sentence (if applicable) by 

clicking on the calendar icon and choosing the date from the calendar. If there is a neutral 
citation, enter it. 

 
20. Enter the name of the Court of Queen’s Bench Justice. Begin typing the last name of the 

justice and then make the appropriate selection from the names that appear. 

 
21. Enter the Location of the Summary Conviction Appeal. Begin typing the first three letters and 

make the appropriate selection. If there is more than one option, hover your mouse over the 
name to select the correct one 
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22. Enter the Court of Queen’s Bench 

File #. If there is more than one 
file number, click on +Court of 
Queen’s Bench File #. 

 
23. Enter the Date of the decision of the summary conviction appeal by clicking on the calendar 

icon and choosing the date from the calendar. If there is a neutral citation, enter it. 

 
Costs or Other Type 

24. Make the appropriate selection for Which court made the order for which permission to 
appeal is required?: Provincial Court (Criminal Trial Court) or Court of Queen’s Bench 
(Criminal Trial Court). 
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25. Complete the remaining fields (Name of Judge/Justice, Provincial Court Location/Judicial 
Centre, Provincial Court/Court of Queen’s Bench File #, Date of Decision and Neutral 
Citation) following the directions above. 

Publication Ban/Access Restriction Information 

26. Answer the 5 questions about Publication Ban/Access Restriction Information. 

 
Note:   If questions 1-4 have been answered in the affirmative, or if question 5 was 

answered in the negative, please provide a copy of any relevant order. If the 
order was pronounced orally, please provide the relevant excerpt from the 
transcript of the hearing in which the order was pronounced. If applicable, 
please also provide a copy of the legislation under which a publication ban 
or access restriction applies along with the specifics of the information that is 
to be protected. 

Upload Documents 

27. Upload the Application, Memorandum of Argument and any other supporting documents by 
clicking on Choose File under the appropriate heading. 
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28. When the dialogue box opens, find the file that you want to upload. Select it and then click 

on Open. 

 
Note:  It does not matter how you named your document when you saved it. Once 

the document is uploaded and approved, the Registry will verify and select 
the correct document name. 

29. Once the document is uploaded, click 
on Proceed. 

 
Note:  Documents cannot exceed 100MB. The larger the document, the longer the 

upload will take.  
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30. You will be returned to your My Appeals 
page, and the following message will 
appear at the top of the screen: 

 
The new appeal will appear in your My 
Appeals page, but it will bear an appeal 
number with EF at the end. This is a 
temporary number only and should 
never be used on documents. A 
permanent appeal number will be 
assigned once the notice of appeal has 
been filed. 

 

When you submit a document, you will receive an email acknowledgement of the 
submission. Once your document is reviewed, you will receive another email 
indicating whether the document was rejected, filed, filed on conditions or filed non-
compliant. Emails will be sent from CAMSInquiries@albertacourts.ca. Please ensure 
that your spam filters do not block this email address. 

 
IMPORTANT NOTE    

The email acknowledgements will be sent to the email account of the user who 
was logged in when the document was submitted. For example, if a legal assistant 
was logged in to his or her account and submitted a document for filing, the email 

acknowledging the receipt of the document will be sent to the email address 
associated with the legal assistant and not to the lawyer’s email address. 
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File a Document on an Existing Appeal  

All documents must be in PDF in order to be filed electronically and must comply with the 
formatting requirements set out in the Practice Direction on Electronic Filing. If you need to file a 

photo or video file or another document in a format other than a PDF (e.g., JPEG, MP3, MP4, etc.), 
send it on a USB or CD to the Registry and ensure that it can be easily viewed or played using a 

standard Windows Media Player. 

 

File a Document on an Existing Appeal 

1. Log in to your CAMS account.  

2. Select File a Document or 
Application Materials on an Existing 
Appeal on the left-hand side of the 
page. 

 

Important Note:   These instructions do not apply to a transcript. If you are filing a 
transcript click on “File a Transcript on an Existing Appeal” instead. 

https://cams.albertacourts.ca/public-portal/files/practiceDirection.pdf
https://cams.albertacourts.ca/public-portal/
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3. Locate the appeal on which you will 
file a document. From the Select 
Action drop-down menu, select File 
Document. 

 
Important Note:    These instructions do not apply to an application. If you are filing                            

an application, choose “File Application Materials”. If the 
application is to restore the appeal (including consent letters), 
choose “Restore Appeal”.  

4. After reading the instructions, 
make the appropriate selection 
from the Document Type drop 
down menu. For anything other 
than an Appeal Record, Factum, 
Extracts of Key Evidence or Letter, 
choose Other Materials. If you are 
filing more than one document, you 
must upload each document 
separately. 

 

5. Upload the document by selecting Choose File. 

 
6. When the dialogue box opens, find the file that you want to upload. Select it and then click 

on Open. 
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Important Note:    It does not matter how you named your document when you saved 

it. Once the document is uploaded and approved, the Registry will 
verify and select the correct document name. 

7. Answer the question about Publication Ban/Access Restriction Information: 

 
8. Click on Proceed. 

 
Important Note:   Documents cannot exceed 100MB. The larger the document, the 

longer the upload will take. If you are filing more than one 
document, you must upload each document separately. 

9. You will be returned to your My 
Appeals page, and the following 
message will appear at the top of 
the screen: 
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When you submit a document, you will receive an email acknowledgement of the 
submission. Once your document is reviewed, you will receive another email 
indicating whether the document was rejected, filed, filed on conditions or filed non-
compliant. Emails will be sent from CAMSInquiries@albertacourts.ca. Please ensure 
that your spam filters do not block this email address. 

 
IMPORTANT NOTE    

The email acknowledgements will be sent to the email account of the user who 
was logged in when the document was submitted. For example, if a legal assistant 
was logged in to his or her account and submitted a document for filing, the email 

acknowledging the receipt of the document will be sent to the email address 
associated with the legal assistant and not to the lawyer’s email address. 
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File Application Materials on an Existing Appeal  

All documents must be in PDF in order to be filed electronically and must comply with the 
formatting requirements set out in the Practice Direction on Electronic Filing. If you need to file a 

photo or video file or another document in a format other than a PDF (e.g., JPEG, MP3, MP4, etc.), 
send it on a USB or CD to the Registry and ensure that it can be easily viewed or played using a 

standard Windows Media Player. 

 

File Application Materials on an Existing Appeal 

1. Log in to your CAMS account.  

2. Select File a Document or 
Application Materials on an Existing 
Appeal on the left-hand side of the 
page. 

 

Important Note:   These instructions do not apply to a transcript. If you are filing a 
transcript click on “File a Transcript on an Existing Appeal” instead. 

https://cams.albertacourts.ca/public-portal/files/practiceDirection.pdf
https://cams.albertacourts.ca/public-portal/
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3. Locate the appeal on which you will 
file a document. From the Select 
Action drop-down menu, select File 
Application Materials. 

 
Important Note:   These instructions do not apply to an application to restore an 

appeal (including consent letters). If you are filing an application 
to restore the appeal, choose “Restore Appeal”. These instructions 
also do not apply if you are filing an appeal record, factum, 
extracts of key evidence, letter or any other materials that are not 
an application and supporting materials, In any of those cases, 
chose “File Document”.  

4. After reading the instructions, make the appropriate selection from the Document Type drop 
down menu. Select Application – Miscellaneous regardless of the type of application that you 
are filing. If you are filing more than one document, you must upload each document 
separately. 

 
5. Upload the document by selecting Choose File. 
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6. When the dialogue box opens, find the file that you want to upload. Select it and then click 

on Open. 

 
Important Note:    It does not matter how you named your document when you saved 

it. Once the document is uploaded and approved, the Registry will 
verify and select the correct document name. 

7. Answer the question about Publication Ban/Access Restriction Information: 

 
8. Click on Proceed. 
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Important Note:   Documents cannot exceed 100MB. The larger the document, the 
longer the upload will take. If you are filing more than one 
document, you must upload each document separately. 

9. You will be returned to your My 
Appeals page, and the following 
message will appear at the top of 
the screen: 

 
When you submit a document, you will receive an email acknowledgement of the 
submission. That email will include a link for the online payment of the $50.00 filing 
fee (civil only). Payment must be made immediately. Your document will not be 
processed until payment is made. Neither the Registry nor the Court will be 
responsible for a missed limitation period caused by a failure to make the required 
payment on time. 
 
Once payment is made and your document is reviewed, you will receive another 
email indicating whether the document was rejected, filed, filed on conditions or filed 
non-compliant. Emails will be sent from CAMSInquiries@albertacourts.ca. Please 
ensure that your spam filters do not block this email address. 

 
IMPORTANT NOTE    

The email acknowledgements will be sent to the email account of the user who 
was logged in when the document was submitted. For example, if a legal assistant 
was logged in to his or her account and submitted a document for filing, the email 

acknowledging the receipt of the document will be sent to the email address 
associated with the legal assistant and not to the lawyer’s email address. 
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Restore an Appeal  

All documents must be in PDF in order to be filed electronically and must comply with the 
formatting requirements set out in the Practice Direction on Electronic Filing. If you need to file a 

photo or video file or another document in a format other than a PDF (e.g., JPEG, MP3, MP4, etc.), 
send it on a USB or CD to the Registry and ensure that it can be easily viewed or played using a 

standard Windows Media Player. 

 

Restore an Appeal 

1. Log in to your CAMS account.  

2. Select File a Document or Application 
Materials on an Existing Appeal on 
the left-hand side of the page. 

 

Important Note:   These instructions do not apply to a transcript. If you are filing a 
transcript click on “File a Transcript on an Existing Appeal” instead. 

https://cams.albertacourts.ca/public-portal/files/practiceDirection.pdf
https://cams.albertacourts.ca/public-portal/
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3. Locate the appeal which you seek to 
restore. From the Select Action drop-
down menu, select Restore Appeal. 

 
Important Note:   These instructions also do not apply if you are filing an appeal 

record, factum, extracts of key evidence, letter or any other 
materials that are not an application and supporting materials, In 
any of those cases, chose “File Document”.  

4. After reading the instructions, make the appropriate selection from the Document Type drop 
down menu. If you are filing more than one document, you must upload each document 
separately. 

 
5. Upload the document by selecting Choose File. 

 
6. When the dialogue box opens, find the file that you want to upload. Select it and then click 

on Open. 
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Important Note:    It does not matter how you named your document when you saved 

it. Once the document is uploaded and approved, the Registry will 
verify and select the correct document name. 

7. Answer the question about Publication Ban/Access Restriction Information: 

 
8. Click on Proceed. 

 
Important Note:   Documents cannot exceed 100MB. The larger the document, the 

longer the upload will take. If you are filing more than one 
document, you must upload each document separately. 

9. You will be returned to your My 
Appeals page, and the following 
message will appear at the top of the 
screen: 
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When you submit a document, you will receive an email acknowledgement of the 
submission. That email will include a link for the online payment of the applicable 
restoration fee: $200.00 first restoration; $500.00 second restoration; $1000 third and 
subsequent restoration (civil only). Payment must be made immediately. Your 
document will not be processed until payment is made. Neither the Registry nor the 
Court will be responsible for a missed limitation period caused by a failure to make 
the required payment on time. 
 
Once payment is made and your document is reviewed, you will receive another 
email indicating whether the document was rejected, filed, filed on conditions or filed 
non-compliant. Emails will be sent from CAMSInquiries@albertacourts.ca. Please 
ensure that your spam filters do not block this email address. 

 

IMPORTANT NOTE    
The email acknowledgements will be sent to the email account of the user who 

was logged in when the document was submitted. For example, if a legal assistant 
was logged in to his or her account and submitted a document for filing, the email 

acknowledging the receipt of the document will be sent to the email address 
associated with the legal assistant and not to the lawyer’s email address. 

 

mailto:CAMSInquiries@albertacourts.ca
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Payment of Fees in Civil Matters  

 
 
 
 
 

 
 

 
 

 

Payment of Fees in Civil Matters 

When you submit a document for filing, you will receive an email acknowledgement 
of the submission. That email will include a link to pay the applicable filing fee. You 
must immediately pay the filing fee by clicking on the link (or copying and pasting 
it into your browser):  

https://eservices.alberta.ca/courtofappeal-filing-fees-civil.html. 

IMPORTANT NOTE:  

If your document is one that requires payment, the document will not be processed 
until payment is made. Documents (and payment, if applicable) received on or 
before 4:00 p.m. Mountain Time on a day on which the Registry is open will be 

processed on the day that they are received. Documents (and payment, if 
applicable) received on or after 4:00 p.m. Mountain Time on a day on which the 

Registry is open will not be processed until the next business day. Neither the 
Registry nor the Court will be responsible for a missed limitation period caused by 

failure to make the required payment on time. 

Once you are on the payment page, take the following steps. 

1. Read the instructions and then click on Begin Form. 

The following fees are payable in civil matters: 
Notice of Appeal: $600.00 

Application for Permission to Appeal – Commencement Document: $600.00 
Application for Permission to Appeal – Non-Commencement Document: $50.00 

All other Applications (other than to Restore): $50.00 
Application to Restore an Appeal (including consent orders/letters): 

First Restoration: $200.00 
Second Restoration: $500.00 

Third and Subsequent Restoration: $1000.00 

There are no fees payable in criminal matters. 
 

https://eservices.alberta.ca/courtofappeal-filing-fees-civil.html
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2. Complete the fields in the form.  
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First Name = the first name of the 

person making the payment 
Last Name = the last name 
of the person making the 

payment 

 

Style of Cause = the names 
of the parties to the appeal. 

 

Appeal Number = the appeal number to which 
the payment applies. If you are making a 

payment for a commencement document, you 
will not yet have an appeal number. In that case, 

you can leave this field blank 

Application Fee = select the appropriate 
fee(s). (E.g., If you are filing a notice of 

appeal and an application for a stay at the 
same time, you would select both $600 and 

$50 for a total payment of $650.) 

3. Once all fields are complete, click Submit.  
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4. Confirm that your Order Details are correct and then click Go to Secure Checkout 

 
5. Enter your email address in the Guest Checkout and select your method of payment (Credit 

Card or Interac Online). 

 
6. Enter your Billing Information and then click Submit. 
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a. If Credit Card is selected, enter your credit 

card details, accept the terms and 
conditions and then click Place Order 
 

b. If Interac Online is selected, accept the 
terms and conditions and then click Place 
Order. You will be redirected to the Interac 
Online Website where you can select your 
applicable banking institution. Follow the 
instructions to proceed. 
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7. Once payment has been received, a confirmation will appear. You can view or print your 
receipt from this page. An order confirmation email with the details of the order will also be 
sent to the email address that you provided in the guest checkout. 
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Formatting 
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Electronic Filing Formatting Requirements Overview 
A document filed electronically must adhere to the following formatting requirements. 

File Format - PDF 

All documents filed electronically must be submitted as a PDF file. The Electronic Filing Portal is 
structured to automatically reject documents in Word or other file formats. (If you wish to file a 
video or audio file, provide it on USB or CD to the applicable Registry and ensure that it can be 
easily viewed or played using a standard Windows Media Player.) 

Where possible, documents such as factums, applications, memorandums of argument, 
affidavits and correspondence should be created in Word and then converted to PDF before 
being filed electronically. Printing a document and then scanning it to PDF will compromise the 
aesthetic value and functionality of the document. 

• See Convert a Word Document to PDF 

Other documents, such as appeal records and extracts of key evidence, will almost always be 
created by scanning and combining individual documents into a single PDF file. It is possible to 
create that single PDF file by feeding all of the documents into a scanner at once, but if 
individual documents already exist in PDF format, it is preferable to combine those individual 
PDFs into one file using Adobe rather than a scanner. Additionally, Adobe can be used to 
combine a Word document (e.g., cover page) with a PDF document to create a single PDF file. 

• See Combine Several Documents into a Single PDF File 

File Format - OCR 

To ensure search capability within the document, all documents filed electronically must be 
submitted with Optical Character Recognition (OCR).  
To determine whether a document has OCR, take these steps: 

• Open the document. 
• Use the keyboard shortcut Ctrl+F to open the Find menu. 
• Type a word or phrase that occurs in the document (e.g., respondent). 
• Click Next. If the document has OCR, the word or phrase that you searched for will be 

highlighted each time it appears in the document. 
 

• See OCR (Optical Character Recognition) – Recognize Text in PDF Documents 

 
  



CAMS MANUAL 

82 
Version 2.2 

File Size 

All documents filed electronically must not exceed 100 MB in size. The Electronic Filing Portal is 
structured to automatically reject any document that exceeds this size. If you require assistance 
to check the size of your file, or to compress it, refer to the following resource. This resource 
also contains tips on reducing the size of a file when a scanner is used to create that file. 

• See Compress a PDF File 

If the document cannot be reduced to less than 100 MB in size, then the document must be 
divided into parts, each less than 100 MB, and each part must be filed as a separate PDF 
(volume 1, volume 2, etc.). In that case, efforts should be made to ensure that each volume 
ends and begins at a convenient location (e.g., at the beginning of any entry in the table of 
contents). 

Coloured Covers 

The requirements for coloured covers for appeal records, factums, extracts of key evidence, and 
authorities (if any) continue to apply to documents filed electronically. That means that you will 
need to add a coloured background to the first page of your document before filing it. If the 
colour is missing, or if it is the wrong one, the document will be filed on the condition that a 
replacement document is filed with the correct coloured cover. The Registry will provide a 
deadline within which you must do that. 

• See Add a Colour Background to a PDF Document 
 

Pagination 

Other than transcripts, the page number of all documents must begin with the first page or 
cover as page 1 and use only standard numerals (e.g, 1, 2, 3 etc.). That means that page 
numbering for appeal records (P1, P2, F1, F2, etc.) and for extracts of key evidence (A1, A2, R1, 
R2, I1, I2, etc.) do not apply to documents filed electronically. If a document is created in Word 
(e.g., factum), page numbers should be added to the Word version of the document before it is 
converted to a PDF. But other documents, such as appeal records and extracts of key evidence, 
will almost always be created by scanning and combining individual documents into a single 
PDF file. In that case, page numbers will need to be applied to the PDF file. (If there are existing 
page numbers on individual documents that are included in the appeal record or extracts of key 
evidence, they do not need to be removed.) 
In addition, the Adobe page counter for each document must match the consecutive page 
numbering of the document. In other words, if you type “5” in the Adobe page counter at the top 
of the document, then you should be taken to the page in the document that displays page “5”. 

If the pagination is missing, or the Adobe page counter does not match, the document will be 
rejected. 

• See Apply Page Numbers to a PDF Document 
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NOTE: Pagination (and other formatting requirements) for transcripts has not changed 
and will continue to require compliance with the Electronic Transcript 
Checklist. Please note that when you order a transcript from Transcript 
Management Services (TMS), it is very important that you advise them that the 
transcript is required for an appeal. Otherwise, the transcript may not have all 
of the necessary formatting features when you receive it. 

 

Bookmarks 

Any document filed electronically that exceeds 5 pages must include an electronic bookmark: 
a) to the cover page listing the name of the document, the name of the party filing the 

document, the appeal number and a brief style of cause  
b) to each heading, subheading and component of the document (e.g., as listed in the table 

of contents), and 
c) to the first page of each tab, exhibit or attachment of the document. 

The bookmark for each tab, exhibit or attachment to a document must include the letter or 
number of the tab, exhibit or attachment and a description of the tab, exhibit or attachment. 
In other words, every entry in the Table of Contents of a document must be bookmarked. For 
example, a factum must include bookmarks to each part of the factum (e.g., Facts, Grounds of 
Appeal, Standard of Review, Argument, Relief Sought) and to any sub-headings within each part 
of the factum such as the various grounds of appeal or arguments made. Appeal records or 
extracts of key evidence must include a bookmark to each document included in them, and the 
name of that bookmark must correspond to the name of the particular document. Affidavits 
must include bookmarks to each exhibit. Any type of written submission with attachments that 
exceeds 5 pages must also contain bookmarks as set out above. 

Factums should be created in Word and formatted in such a way that PDF bookmarks are 
automatically created when the document is converted to PDF. Other documents, such as 
appeal records and extracts of key evidence, will almost always be created by scanning and 
combining individual documents into a single PDF file. In the latter case, bookmarks will need to 
be added to the PDF file using Adobe. 
Documents with bookmarks must be formatted so that they automatically display the 
bookmarks panel when opened. (Electronic transcripts currently have this functionality). If the 
document does not display the bookmarks panel when opened, click on the Bookmarks icon on 
the left-hand side of the document to display the bookmarks panel. It will be obvious from a 
review of the bookmarks panel whether or not the document contains the required bookmarks. 

If a document that exceeds 5 pages does not contain any bookmarks, it will be rejected.  
If the document contains bookmarks, but they are not working properly, the document will be 
rejected. 

If the document contains the required bookmarks (and they work properly), but it has not been 
saved to automatically display the bookmarks panel when opened, the document will not be 
rejected. Instead, the Registry will make the necessary adjustment to the document. 

https://www.albertacourts.ca/docs/default-source/ca/electronic-transcript-checklist.pdf?sfvrsn=b14ad980_6
https://www.albertacourts.ca/docs/default-source/ca/electronic-transcript-checklist.pdf?sfvrsn=b14ad980_6
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• See Add a Bookmark to a Document 
 

Hyperlinks 

Any document filed electronically that includes a reference to a case or statutory authority must 
include, in a Table of Authorities, a hyperlink to an electronic version of that case or statutory 
authority, if available. The hyperlink must link to a publicly accessible (i.e., free) website such as 
CanLII.  

This will most often apply to factums. Every factum must have a Table of Authorities. Each 
authority in the table must include a hyperlink to an electronic copy of the case if it is available. 
The same is true for memorandums of argument. 
If a hyperlink to the authority is provided, then you do not have to provide an electronic copy of 
that authority. If a hyperlink to the authority is not provided, then you must append a copy of the 
authority to your document and then include a bookmark to that authority as described above. 

If the Table of Authorities to a factum does not contain any hyperlinks (and there is no notation 
indicating that hyperlinks are not available), the document will be rejected.   
If the Table of Authorities contains hyperlinks, but they do not work properly, the document will 
be rejected. 

• See Add a Hyperlink to a Document 
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Convert a Word Document to a PDF Document 

A document filed electronically must be created and submitted in portable document format (PDF) 
or created in Word and saved as a PDF from which text can be copied and pasted.  

Where possible, documents such as factums, applications, memorandums of argument, affidavits 
and correspondence should be created in Word and then converted to PDF before being filed 
electronically. Printing a document and then scanning it to PDF will compromise the aesthetic 

value and functionality of the document. 

NOTE: Any document filed electronically that exceeds 5 pages must include 
electronic bookmarks. In addition, any document that includes a reference 
to a case or statutory authority must include, in a table of authorities, a 
hyperlink to an electronic version of that case or statutory authority if 
available. 
It is recommended that bookmarks and hyperlinks be added to the Word 
version of a document before it is converted to PDF (although it is possible to 
add bookmarks and hyperlinks directly to a PDF). For instructions on how to 
do that, see the separate instruction sheets entitled “Add a Bookmark to a 
Word Document” and “Add a Hyperlink to a Document”. 

There are two ways to convert a Word document to PDF: Save as Adobe PDF and Save as 

Save as Adobe PDF 

1. Open the document in Word and in the 
top left-hand corner, select File and then 
Save as Adobe PDF File.  
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2. The Acrobat PDFMaker message may 
appear. If so, select Yes. 

 
3. Ensure the File Name is correct, and the Save as type is PDF files (*.pdf), by using the drop 

down in the Save as type field. Select Save. 

 

4. After saving the PDF, you will be returned to your Word document, and the PDF version will 
open. 

Save as  

1. Open the document in Word, and in the 
top left-hand corner, select File and then 
Save As 
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2. Select Browse.  

 

3. The Save As dialogue box will open. Find 
the location to where the document will be 
saved and ensure the name of the 
document is correct. In the Save as type: 
list, choose PDF (*.pdf) from the drop-
down menu. 

 

4. If you have used headings in your 
document (e.g., in a factum), click on 
Options.  
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5. An Options box will appear. Ensure that 
the Create bookmarks using: box is 
checked and that Headings is selected. 
Click OK.  

 

6. Click Save. Once your document is saved, 
the PDF file will open. 
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Combine Several Documents into a Single PDF File 

Appeal records and extracts of key evidence will almost always be created by scanning and 
combining individual documents into a single PDF file. It is possible to create that single PDF file 

by feeding all of the documents into a scanner at once, but if individual documents already exist in 
a PDF format, it is preferable to combine those individual PDFs into one file using Adobe rather 

than a scanner. Additionally, you may want to combine a Word document (e.g., cover page) with a 
PDF document to create a single PDF file. These instructions describe how to do that. 

NOTE:  You will require Adobe Acrobat to format your document. Adobe Reader does 
not have the necessary functionality to take these steps. 
There are several methods for combing several documents into a single PDF 
file and this is just one of them. These instructions were prepared using Adobe 
Acrobat Pro 2017 and are intended only as a general description of the 
process. Your procedure may vary depending on which PDF creation software 
you are using. 

Use the Combine Files tool in Adobe Acrobat to merge Word documents, existing PDF documents 
and more. Adobe Acrobat lets you preview and arrange the documents and pages before saving 
the file. You can delete unwanted pages and move individual pages from a document anywhere 
among the pages being combined. 

Before beginning, ensure that you have copies of all the required documents saved to your 
computer. They do not need to be saved as PDF files. Acrobat will convert other file formats (e.g., 
Word) to PDF when it combines the files. 

Combine Several Documents into a Single PDF File 

1. Open Adobe and in the 
top, left hand corner, 
click on Tools 
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2. In the Create & Edit 
group, click on Combine 
Files. 

 
3. The Combine Files interface will be displayed with the toolbar at the top. Click on Add Files 

(twice). 

 

4. Locate the folder where 
the files to be combined 
are saved. 

 
5. Select the file(s) to be combined and then click Open. Repeat this process until you have 

added all of the documents that you want to combine.  

6. Once you have added all the files to be combined, click Combine on the top right-hand side. 

 

NOTE:   You do not have to convert a Word document to PDF before combining.  
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A status dialogue box at the bottom of the screen will show the progress of the file conversions 
(the more documents you have to combine, the longer it will take). 

7. Once Adobe is finished 
combining your 
documents, the single 
PDF file will open. It will 
be named Binder.pdf. 
Click File>Save As, 
rename and Save to your 
preferred location.  

 

Re-organizing or Adding/Deleting Pages (if necessary) 

If, after combining your files and saving your document, pages or files need to be re-organized or 
you realized that you forgot to add a page or document (or you added one by mistake), there are 
several editing options available. It is not always necessary to start over. Take these steps: 

8. Open your document and 
in the top, left hand 
corner, click on Tools 

 

9. In the Create & Edit 
group, click on Organize 
Pages. 

 

a) Rearrange files/pages 

If the files or pages were not added in the correct order, you can rearrange them. Click on the 
page and then drag-and-drop it into the correct position. As you drag, a blue bar moves between 
the files or pages to indicate the current position. 
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b) Delete files/ pages 

If you added a file or page by mistake, you can delete it, hover your mouse over the page and 
then click the Delete icon. 
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c) Adding a page or document 

Select Insert Page > From File 

 

The Select File to Insert dialogue 
box will appear. Locate the 
document that you wish to insert 
and select Open.  

 
NOTE: You do not need to 

convert the document 
to PDF before you insert 
it. 

 

A box will appear asking where the 
new document should be inserted. 
Make the appropriate selection 
and select Ok.  

 

A progress window will appear. Once the insertion is complete, confirm its placement and re-
save the document. 
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OCR (Optical Character Recognition) - Recognize Text in PDF 

Documents 
Optical Character Recognition, or OCR, is a technology to recognize text inside images, such as 

scanned documents and photos.   

A document filed electronically must be enabled with OCR or saved as a PDF from which text can 
be copied and pasted failing which the document will not be accepted for filing. 

Where possible, documents such as factums, applications, memorandums of argument, affidavits 
and correspondence should be created in Word and then converted to PDF before being filed 

electronically. (See the separate instruction sheet “Convert a Word Document to a PDF”). Printing 
a document and then scanning it to PDF will compromise the aesthetic value and functionality of 
the document. When a document is created in Word and converted to PDF, the PDF version of the 

document should automatically be enabled with OCR.  

Some scanners have built-in OCR so that the text in any PDF file created from it will be 
searchable. Any scanner can effectively be turned into an OCR scanner by using the 
appropriate software. Please refer to your scanner user manual for software features. 

Checking a Document for OCR 

To check whether a PDF file is enabled with OCR, take the following steps: 

• Open the PDF document. 
• Use the keyboard shortcut Ctrl+F to open the Find menu. 
• Type a word or phrase that occurs in the document (e.g., respondent). 
• Click Next.  
•  

If the document has OCR, the word or phrase that you searched for will be highlighted each time 
it appears in the document.  

Adding OCR to a Document 

NOTE: You will require Adobe Acrobat to format your document. Adobe Reader does 
not have the necessary functionality to take these steps. 

 There are several methods of adding OCR information to a PDF file and this is 
just one of them. The instructions are intended only as a general description of 
the process. These instructions were prepared using Adobe Acrobat Pro 2017. 
Your procedure may vary depending on which PDF creation software you are 
using. 



CAMS MANUAL 

95 
Version 2.2 

1. Open Adobe and in the top, left hand 
corner, click on Tools 

 
2. In the Create & Edit group, click on Enhance Scans. 

 

3. The document will appear with a selection of items displayed at the top. Select Recognize 
Text > In this File. 

 

4. Another selection of items will appear. In the drop-down menu next to Pages, select All 
Pages and then select Recognize Text.  Note that if your document is only one page, there 
will be no option to select from the drop-down menu. In that case, simply select Recognize 
Text to proceed. 
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5. A notification will appear at the bottom of 
the document to indicate that the document 
is converting to a searchable image. The 
larger the document, the longer it will take 
for the OCR to be applied. 

 

Note: If the PDF document was originally created with a word processor, you may 
receive a message that says “This page contains renderable text”. If so, select 
the “Ignore future errors in this document” check box and then select OK. 

6. Once the OCR is applied, search for text in the PDF to ensure that the process has worked 
successfully. Use the keyboard shortcut Ctrl+F to open the Find menu. Type a word or 
phrase that occurs in the document. Click Next. The word or phrase will be highlighted each 
time it appears in the document. 

 

7. Save the document. 
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Compress a PDF File 

Notwithstanding rules 14.29(d), 14.31(f), 14.87(1)(f) and 16.37(1)(f), a document filed 
electronically may exceed 200 pages as long as the file size is 100 megabytes or smaller. In other 

words, documents such as Appeal Records and Extracts of Key Evidence  
should be filed as a single PDF.  

Optimizing Your Scanner Settings 

Creating a PDF file using a scanner increases file size substantially. To reduce the file size, 
please: 

• Ensure that the Color mode on the scanner is set to Black and White for all pages that 
contain only text.  Black and White creates a much smaller file than a Greyscale or Color 
scan.   

• If your document does contain pictures or exhibits, only those pages should be scanned 
in using Color or Greyscale. 

• Set the scan quality settings to either 200 DPI or 300 DPI.  Increasing the DPI (dots per 
inch) can greatly increase the file size.  Ensure to go no larger than 300 DPI. 

Checking the Size of a PDF File 

1. Open the document in Adobe Acrobat 
and in the top, left-hand corner of the 
document, select File>Properties. 
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2. The Document Properties dialog box 
will open. Click on the Descriptions tab 
and locate the file size in the Advanced 
section. The file size must not exceed 
(100MB).  

 

Compressing a PDF File 

NOTE: You will require Adobe Acrobat to format your document. Adobe Reader does 
not have the necessary functionality to take these steps. 

There are several methods for compressing the size of a PDF document and 
this is just one of them. These instructions were prepared using Adobe Acrobat 
Pro 2017 and are intended only as a general description of the process. Your 
procedure may vary depending on which PDF creation software you are using. 

If you have optimized your scanner settings, and your PDF document still exceeds 100 
megabytes, follow these instructions. If the document still exceeds 100 megabytes, the 
document must be divided into parts, each less than 100 megabytes, and each part must be 
filed as a separate PDF (each with its own cover page). Efforts should be used to ensure that 
each part ends and begins at a convenient location (e.g., at the beginning of an entry in the 
table of contents). 
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1. Open Adobe and in the top, left hand 
corner, click on Tools 

 
2. Scroll down until you see the Protect & 

Standardize group and then click on 
Optimize PDF. 

 
3. The document will appear with a selection of items displayed at the top. Select Reduce File 

Size.  

 

4. The Reduce File Size dialog box will 
open. Ensure the Acrobat Version 
Compatibility is set to Retain existing. 
Select OK.  

 

5. The Save As dialog box will open. Keep the same file name to overwrite the original PDF with 
the optimized PDF or select a new name or location for your compressed file. Select Save. 
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Add a Colour Background to a PDF Document  

 
 
 
 
 

 
 

 
 

 

Preparing the Document 

Where possible, factums should be created in Word and then converted to PDF before being filed 
electronically. Printing a document and then scanning it to PDF will compromise the aesthetic 
value and functionality of the document. If the document is created in Word and then converted 
to PDF, it is possible to add a coloured background to the cover page. These instructions describe 
how to do that. 

However, appeal records and extracts of key evidence will almost always be created by scanning 
and combining individual documents into a single PDF file. If the cover page is also scanned, it is 
not possible to add a coloured background to the cover page (as Adobe will not permit you to add 
colour to a page that has been scanned). Therefore, a cover page should be created in Word and 
then combined with the rest of the documents to create the single PDF file. (See the separate 
instruction sheet “Combine Several Documents into a Single PDF File”.) Doing so will allow a 
coloured background to be added to the cover page following these instructions.   

Adding a Colour Background 

NOTE:  You will require Adobe Acrobat to format your document. Adobe Reader 
does not have the necessary functionality to take these steps. 

 
These instructions were prepared using Adobe Acrobat Pro 2017 and are 
intended only as a general description of the process. Your procedure may 
vary depending on which PDF creation software you are using. 

The provisions of the Alberta Rules of Court prescribing the colour of covers for 
specific documents continue to apply to a document filed electronically. The 

following coloured covers are required: 
Appeal Record – RED. 

Appellants Factum – BEIGE. 
Respondents Factum – GREEN. 

Intervenors Factum – BLUE. 
Appellants Extracts of Key Evidence – YELLOW. 
Respondents Extracts of Key Evidence – PINK 

No other documents, other than those listed, require coloured covers, including 
application materials. 
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1. Open the document in Adobe Acrobat and 
in the top, left-hand corner of the 
document, select Tools. 

 
2. In the Create & Edit group, select Edit PDF. 

 
3. The document will appear with a selection 

of items displayed at the top. Select More 
> Background > Add.  

 
4. The Add Background dialogue box will appear, and the document will be displayed in the 

dialog box. Ensure the Source > From colour radio button is selected and then click on the 
colour square to the right of it. (If no coloured background has yet been applied, the colour 
square will be white.) 
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5. A selection of colours will appear. Select 
the required colour to be applied to the 
cover page. 
 
(The pre-set colours will not have an 
obvious choice for beige – the colour 
required for the appellant’s factum. See 
further instructions below.) 

 
6. Once a colour is selected, the colour will 

be added to the document displayed in the 
dialogue box. 

 
7. Select Page Range Options in the upper, right-hand corner of the Add Background dialogue 

box. 
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8. A Page Range Options dialogue box will 
appear. Select the Page from radio button 
and then enter the page range to which 
the coloured background will be added 
(i.e., from 1 to 1). Select OK.  
 

Note:  If you do not take this step, the 
colour will be added to every 
page of the document.) 

 

 
9. In the Add Background dialogue box, 

select OK. Save the document.  

 

Adding a Beige for an Appellant’s Factum Background 

1. When the colour options appear, select 
Other Colour.  
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2. When the Color dialogue box appears, 
enter the following values and then click 
OK:  
 

Hue: 20 
Sat: 240 
Lum: 210 
Red: 255 
Green: 233 
Blue: 191  

 
3. So that you will always have this colour as 

an option, once the values are entered, 
click on Add to Custom Colors. The colour 
will be added to the Custom colors 
section. 
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Apply Page Numbers to a PDF Document  

Other than for transcripts, whether page numbers are added to a document created in Word or to 
a PDF document: 

• the page numbering of the document must begin with the first page or cover as 
page 1 and use only standard numerals (e.g., 1, 2, 3), and 

• the Adobe page counter for each document must match the consecutive page 
numbering in the document. 

The pagination requirements for transcripts have not changed. 

Preparing the Document 

Where possible, documents such as factums, applications, memorandums of argument and 
affidavits should be created in Word and then converted to PDF before being filed electronically. 
Printing a document and then scanning it to PDF will compromise the aesthetic value and 
functionality of the document. If the document is created in Word, page numbers should be added 
to the Word document before it is converted to PDF 

Other documents, such as appeal records and extracts of key evidence, will almost always be 
created by scanning and combining individual documents into a single PDF file. (Please see the 
separate instruction sheet “Combine Several Documents into a Single PDF File”.) In that case, 
page numbers will need to be applied to the PDF file. These instructions explain how to do that 

Applying Page Numbers 

NOTE:  You will require Adobe Acrobat to format your document. Adobe Reader 
does not have the necessary functionality to take these steps. 

 
These instructions were prepared using Adobe Acrobat Pro 2017 and are 
intended only as a general description of the process. Your procedure may 
vary depending on which PDF creation software you are using. 

1. Open the document in Adobe Acrobat and 
in the top, left-hand corner of the 
document, select Tools. 
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2. In the Create & Edit group, select Edit PDF. 

 
3. The document will appear with a selection 

of items displayed at the top. Select More 
> Bates Numbering > Add. 

 
4. The Bates Numbering dialog box will 

appear and the document will be 
displayed in the dialog box. Select OK. 

 
5. The Add Header and Footer dialog box will appear. Choose the placement of the page 

numbers on the document by placing your cursor in the appropriate box (e.g., Center Header 
Text will center the page numbers at the top of each page, Right Header Text will display the 
page numbers in the top, right-hand corner of each page and so on). 
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6. In the Add Header and Footer dialogue 
box, select the Insert Bates Number 
button.  

 
7. The Bates Numbering Options dialog box will appear. If the number of pages in your 

document does not exceed 999, enter “3” in the “Number of Digits” field. (Note that it will be 
defaulted to 6). Doing so will display page numbers as 001, 002, 003 and so on. If the 
number of pages in your document is between 1000 and 9999, enter “4” in the “Number of 
Digits” field. Doing so will display page numbers as 0001, 0002, 0003 and so on. 

 
8. The Start Number will be defaulted to 1. In most cases, this should not be changed. That 

would mean that the first page of your document will be page number 001 (or 0001 
depending on the value assigned to the Number of Digits field above). The Prefix and Suffix 
fields can remain blank. Select OK. 
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9. Select OK. The Progress window will 

appear. (If your document is not lengthy, 
the Progress window may appear and then 
disappear very quickly.) 

 
10. Once the page numbers have been 

sucessfully applied, a confimation window 
will appear. Select OK. Page numbers will 
now appear on the document.  

 
NOTE:   If you make a mistake, in Tools >  Create & Edit > Edit, choose More > Bates 

Numbering > Remove. This will remove all page numbers and you can start 
again.  

11. Verify that the Adobe page counter at the top of the document matches the page numbering 
added to the document.  
 
For example, if you enter “4” in the Adobe page counter, it should take you to the page that 
has “4” displayed on it (or 0004 depending on the value assigned to the Number of Digits 
field above).  
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Add a Bookmark to a Document  
Any document filed electronically that exceeds 5 pages must include an electronic bookmark 

• to the cover page listing the name of the document, the name of the party filing the 
document, the appeal number and a brief style of cause 

• to each heading, subheading and component of the document (e.g., as listed in the  
table of contents), and 

• to the first page of each tab, exhibit or attachment of the document. 

The bookmark for each tab, exhibit or attachment to a document must include the letter or 
number of the tab, exhibit or attachment and a description of the tab, exhibit or attachment. 

 

Adding a Bookmark to a Word Document 

Where possible, documents such as factums, applications, memorandums of argument and 
affidavits should be created in Word and then converted to PDF before being filed electronically. 
Printing a document and then scanning it to PDF will compromise the aesthetic value and 
functionality of the document. If the document is created in Word, page numbers should be added 
to the Word document before it is converted to PDF 

Bookmarks can be created in Word using “Styles”. Word has several pre-formatted Styles that 
can be applied to a document. A Style is a set of formatting characteristics, such as font name, 
size, paragraph alignment and spacing, that can be quickly applied to headings, sub-headings, 
paragraphs, quotations and other sections of a document. The pre-formatted Styles can also be 
modified to a user’s preference. 

Any text to which a style is applied can be turned into a bookmark. These instructions describe 
how to set up a Word document so that bookmarks are automatically created when the document 
is converted to a PDF 

NOTE:  These instructions were prepared using Microsoft Office Professional Plus 2019 
and assume that the document you are creating is a factum.  However, these 
instructions can be used for any document created in Word. If you have not 
used Styles in Word before, begin this process with the final version of your 
factum with your preferred formatting. In the future, you will be able to use 
the Styles you create to format headings, subheadings and other sections of 
your factum as you are drafting the document. 
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1. Open the factum in Word and highlight the 
first heading (e.g. Part 1 – Facts). 

 

2. Locate the Styles window under the Home tab. 

 

3. With “Part 1 – Facts” still highlighted, hold the curser of your mouse over Heading 1 in the 
Styles window. (Do not click the mouse.) You may notice that the formatting of the 
highlighted text changes based on the pre-loaded formatting that Word assigned to Heading 
1.  
 
Update Heading 1 to match the formatting that you created for the main headings in your 
factum. Hover your mouse over Heading 1 and right click. Select Update Heading 1 to Match 
Selection 

 

The Heading 1 option in the Styles menu will be updated to match your existing formatting. 
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4. Repeat the above steps for any subheadings or other parts of your document. For example, 
you might use “Heading 2” for all sub headings, “List Paragraph” for all numbered 
paragraphs, “Quote 1” for all quotations, “Regular Text” for the body of the document and so 
on. 

5. Save your formatting selections so that they become the default selections for your next 
factum. Follow these steps: 

a) In the Styles menu, highlight the Heading with the format you wish to save for future 
use. 

 

b) Right-click and select Modify from the 
menu.  

 

c) The following window will appear. Select New Documents based on this template and 
click OK. 
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The formatting you created for the heading should now be saved for use in new 
documents. You will need to repeat this step for each heading level that you have created 
(Heading 1, Heading 2, List Paragraph, Quote 1, etc.). 

TIP:    You can also use Styles to automatically create a Table of Contents 

6. Save the factum as a PDF file. Confirm that the bookmarks appear and make any necessary 
modifications (see below). Once all bookmarks are complete, save the PDF so that it 
automatically displays the Bookmarks Panel when opened (see below). 
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Adding a Bookmark to a PDF Document 

These instructions describe how to add a Bookmark to a PDF document. However, documents 
such as factums, memorandums of argument and affidavits should be created in Word and then 
converted to PDF before being filed electronically. Printing a document and then scanning it to 
PDF will compromise the aesthetic value and functionality of the document. It is possible to create 
a Word document so that bookmarks are automatically created when the document is converted 
to a PDF. For instructions on how to do that, see above. 

NOTE:  You will require Adobe Acrobat to format your document. Adobe Reader 
does not have the necessary functionality to take these steps. 

 
These instructions were prepared using Adobe Acrobat Pro 2017 and are 
intended only as a general description of the process. Your procedure may 
vary depending on which PDF creation software you are using. 

1. Open the document in Adobe Acrobat, and 
on the left-hand side of the document, 
select the Bookmarks icon to display the 
Bookmarks panel.  

 
2. If the Bookmarks icon is not visible, at the top of the document select View > Show/Hide > 

Navigation Panes > Bookmarks. 
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3. Find the place on the page to which the 

bookmark will be added. Using your 
mouse, select the area of the page that 
you want to be bookmarked. 

 
4. On the left-hand side of the page, in the 

Bookmarks Panel, select the New 
Bookmark icon.  
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5. The bookmark will be added to the 
document and will appear in the 
Bookmarks Panel. Note that the text 
selected above becomes the label of the 
bookmark.  

 
6. Continue to add Bookmarks following the 

steps above. 
 

7. Test your bookmarks by going to each one in the Bookmark Panel, selecting it and ensuring 
that it opens to the page that it corresponds to. Save the document. 

Modifying a Bookmark in a PDF Document 

Adjust the position or order 

If you need to adjust the position or order of 
the bookmarks in the Bookmarks Panel, click 
to drag it up, down, left or right in the list 
hierarchy.  
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Rename the title of a bookmark 

If you need to rename the title of a bookmark, 
double-click on the Bookmark and type the 
new name. 

 
Delete a bookmark 

If you need to delete a bookmark, in the 
Bookmarks Panel click on the Bookmark and 
then select the trashcan icon (or hit the 
delete button).  
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Change the colour or formatting of a bookmark 

In the bookmarks panel, select the bookmark 
that you want to modify and then under the 
View menu, select Show/Hide > Toolbar Items 
> Properties Bar. A Bookmark Properties 
dialogue box will appear. 

 
To change the colour of a bookmark, click on 
Color and make your selection. 

 
To italicize or bold a bookmark, click on the 
drop-down arrow next to Plain and make your 
selection. 
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The changes made will appear in the 
bookmarks panel. 

 

Saving a PDF Document to Automatically Display the Bookmark Panel 
When Opened 

1. Open the document in Adobe Acrobat and 
in the top, left-hand corner of the 
document, select File > Properties. 

 
2. The Document Properties dialog box will 

open. Select Initial View tab. 
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3. In the Navigation tab drop-down list, 
select Bookmarks Panel and Page. Select 
OK.  

 
4. Save the document and close it. Re-open 

it to verify that the document opens with 
the Bookmarks panel automatically 
displayed. 
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Add a Hyperlink to a Document  

A document filed electronically that includes a reference to a case or statutory authority must 
include, in a table of authorities, a hyperlink to an electronic version of that case or statutory 

authority if available. 
The hyperlink must link to a publicly accessible website such as CanLII, WorldLII or a similar 
website for the applicable court, tribunal or decision maker. Electronic secondary sources 

must also be hyperlinked in the same manner if available. 

The most efficient way to add a hyperlink to a document is to do so in Word 
before the document is converted to a PDF. Any hyperlink added to the Word 
document will be maintained in the PDF version. However, it is possible to also 

add a hyperlink directly to the PDF version.  
These instructions describe both methods. 

 

Adding a Hyperlink to a Word Document 

NOTE:  These instructions were prepared using Microsoft Office Professional Plus 
2019. 

1. Open the document in Word and using 
your mouse, highlight the text to which 
you want to add a hyperlink. 

 

2. On the Insert tab, select Link. 

 

https://www.canlii.org/en/
http://www.worldlii.org/
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Alternatively, you can right-click on the 
selected text and choose Link on the 
shortcut menu.  

 

3. The Insert Hyperlink dialogue box will open. In the Address field, enter the URL (copy and 
paste it from your browser) and select OK 

 

4. If you don’t see the Address box, make sure Existing File or Web Page is selected under Link 
To on the left-hand side of the Insert Hyperlink dialogue box. 
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5. The text to which a hyperlink was added 
will now be underlined in blue. To confirm 
that the link has been properly created, 
hover the mouse over the blue text. A 
popup box will appear with the URL you 
entered. With the Control key held down, 
click on the link to verify that it works. 
Save the document.  

Adding a Hyperlink to a PDF Document 

NOTE:  These instructions were prepared using Adobe Acrobat Pro 2017 and are 
intended only as a general description of the process. Your procedure may 
vary depending on which PDF creation software you are using. Adobe 
Reader does not have the necessary functionality to take these steps. 

1. Open the document in Adobe Acrobat. 
Using your mouse, select the text to 
which you want to add a hyperlink (i.e., 
highlight the authority). Right click on the 
highlighted text and select Create Link. 
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2. The Create Link dialogue box will open. In 
the Link Appearance section use these 
settings and then click Next. 
 

Link Type: Visible Rectangle 
Line Style: Underline 
Highlight Style: Invert 
Color: Blue 
Line Thickness: Thin 
Link Action: Open a web page 

 
3. The Edit URL dialogue box will open. Enter the URL (copy and paste it from your browser) and 

select OK 

 
4. To confirm that the link has been properly 

created, hover the mouse over the area 
you selected in step 2. A popup box will 
appear with the URL you entered. Click on 
the link to verify that it works. Save your 
document.  
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Tips & Guidelines 
 



CAMS MANUAL 

127 
Version 2.2 

 
Document Preparation Tips 

FOR M 
 
 

 

 

  

Follow these formatting tips when preparing an appeal record, factum or extracts of key 
evidence. Refer to the resources hyperlinked below for detailed instructions. 

 
NOTE: No changes have been made to the way that transcripts are prepared. 

APPEAL RECORD 

Prepared by Transcript Management Services (TMS) 
or Other Commercial Preparer 

1. Obtain electronic version from TMS/Commercial Preparer 
 

2. OCR the appeal record 
• OCR (Optical Character Recognition) – Recognize Text in Scanned PDF 

Documents 
 

3. Add bookmarks 
• Add a Bookmark to a Document 

 
4. Set the bookmarks to automatically display when the document is opened 

• Add a Bookmark to a Document 
 

5. Apply page numbers 
• Apply Page Numbers to a PDF Document 

 
6. Apply red to cover page 

• Add a Colour Background to a PDF Document 

Prepared In-house 

1. Prepare a cover page and table of contents and save them, along with a copy of 
each document to be included in the appeal record, to your computer and then 
combine all documents into a single PDF. 

• Combine Several Documents into a Single PDF File 
 

2. OCR the appeal record 
• OCR (Optical Character Recognition) – Recognize Text in Scanned PDF 

Documents 

COURT OF APPEAL OF ALBERTA 
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ORE INFORMATION 
z  

3. Add bookmarks 
• Add a Bookmark to a Document 

 
4. Set the bookmarks to automatically display when the document is opened 

• Add a Bookmark to a Document 
 

5. Add page numbers 
• Apply Page Numbers to a PDF Document 

 
6. Apply red to cover page 

• Add a Colour Background to a PDF Document 

 

FACTUM 

1. Prepare a factum in Word. Include a cover page and a blank page for the Table 
of Contents. If applicable, also include the Sentence Questionnaire. 
 

2. Apply Styles to all headings 
• Add a Bookmark to a Document 

 
3. Add hyperlinks to table of authorities 

• Add a Hyperlink to a Document 
 

4. Add page numbers with the cover page as page 1 (hide the numbering on the 
cover page if desired) 
 

5. On the blank page reserved for the Table of Contents, create a Table of Contents 
in Word (References > Table of Contents) 
 

6. Save the factum as a PDF 
• Convert a Word Document to a PDF Document 

 
7. Confirm bookmarks appear as desired. Make any revisions as necessary 

• Add a Bookmark to a Document 
 

8. Set the bookmarks to automatically display when the document is opened 
• Add a Bookmark to a Document 

 
9. Confirm hyperlinks work 

 
10.  Apply appropriate colour to cover page 

• Add a Colour Background to a PDF Document 
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EXTRACTS OF KEY EVIDENCE 

1. Prepare a cover page and table of contents and save them, along with a copy of 
each document to be included in the extracts, to your computer and then 
combine all documents into a single PDF. 

• Combine Several Documents into a Single PDF File 
 

2. OCR the extracts 
• OCR (Optical Character Recognition) – Recognize Text in Scanned PDF 

Documents 
 

3. Add bookmarks 
• Add a Bookmark to a Document 

 
4. Set the bookmarks to automatically display when the document is opened 

• Add a Bookmark to a Document 
 

5. Add page numbers 
• Apply Page Numbers to a PDF Document 

 
6.  Apply appropriate colour to cover page 

• Add a Colour Background to a PDF Document 

FOR MORE INFORMATION 
Review the CAMS Manual located at https://cams.albertacourts.ca/public-portal/ 

CAMSInquiries@albertacourts.ca 

https://cams.albertacourts.ca/public-portal/
mailto:CAMSInquiries@albertacourts.ca
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Document Formatting Guidelines 

These guidelines provide suggestions to make electronic documents more functional, 
readable and helpful to judges and court staff who read them, often with collateral benefits 

for lawyers and litigants. 

The following formatting guidelines are suggested but not mandated. Where possible, create 
a factum and memorandum or argument with the following settings: 

      

 

 

 
 

FONT STYLE 

A proportionately spaced serif font such as: 

Century School Book 

Book Antiqua etc. 

 

FONT SIZE 

13 pt. text (including 
footnotes) 

SPACING 

1.2 

MARGINS ALIGNMENT 

1.5 on all 
sides 

Left aligned 
(not justified) 

MISCELLANEOUS 

• Use boldface or italics instead of underlining 
• Do not use ALL CAPS 
• Use curly or smart quotation marks and apostrophes rather than straight 
• If the document contains pictures, do not use a High-Resolution image 

FOR MORE INFORMATION 
Review the CAMS Manual located at https://cams.albertacourts.ca/public-portal/ 

CAMSInquiries@albertacourts.ca 

COURT OF APPEAL OF ALBERTA 

https://cams.albertacourts.ca/public-portal/
mailto:CAMSInquiries@albertacourts.ca
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